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Max’s Toolbox™

Introduction
What is Max’s Toolbox 3?
Max’s Toolbox 3 is an early childhood interface
to Microsoft® Office suitable for children in grades K
through 5. The flexibility of the programs makes
them suitable for teaching children of all
capabilities.
The suite of three products—MaxWrite for Microsoft®
Word, MaxShow for PowerPoint®, and MaxCount for
Excel—gives teachers a platform for incorporating
technology across a wide range of subjects and
lesson plans.

MaxWrite has easy-to-use icons and special tools
that make it fun and easy for students to express
themselves on the printed page. MaxWrite also
includes easy-to-use templates for invitations,
cards, and letters.
MaxShow encourages children to create fun,
powerful presentations with their own sounds
and pictures.
MaxCount gives young students an easy, attractive
way to learn about numbers, charts, and graphs.
Max’s Toolbox 3 contains creativity and management
tools not available in Microsoft® Office.

Max’s Toolbox 3 sits within the Microsoft® Office
environment and uses child-friendly lessons and
features to give young students productive and
creative ways to learn skills they will use throughout
their school years and beyond. Since all the
documents created with Max’s Toolbox 3 are actually
Microsoft® Office documents, they can be shared
with anyone who has Microsoft® Office.



MaxPaint is a fun and engaging drawing program
that works easily with all three programs.



MaxRecorder is a customized audio recording
and creativity tool built into MaxShow.

System Requirements

Checking your version of Office

The following system requirements are mandatory
for Max’s Toolbox 3:

If you are not sure what version of Office you have,
follow the steps below.

 Microsoft®
Microsoft®
Microsoft®
 Microsoft®

Windows® XP SP 2 with 512Mb RAM or
Windows® Vista with 1Gb RAM or
Windows® 7 with 1Gb RAM
Office 2007 or Microsoft® Office 2010

In addition, Max’s Toolbox 3 includes a set of
powerful Management Tools that allow teachers to
customize features and content for the needs of each
student.

1.

Launch Microsoft® Word.

2.

From the Help menu, choose About Microsoft®
Office Word.
Note: If you’re using Office 2007, click the Office
Button. Then, click the Word Options button. In the
Resources section, click the About button.
If you’re using Office 2010, click the File tab, and
choose the Help option.

The following systems requirements are the
recommended minimum for Max’s Toolbox 3:
 Intel Pentium III 500Mhz or higher for Windows XP
SP 2
 Intel Pentium III 800Mhz or higher for Windows
Vista
 1 gigahertz (GHz) processor or higher for Windows
7
 Minimum 1000 x 600 and 24 bit color
 CD-Rom Drive
 Windows Media Player for Insert Movie feature
 Sound card and speakers for text to speech
feature
 Microphone for recording feature
 380Mb Available Hard Disk Space for Complete
Installation.

3.

Look for the version number at the top of the
About Microsoft Office Word dialog box.

In the example below, the user has Office 2007 SP1.
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3.

Click the OK button to create the xml support
file.

Support Tool

4.

The Support.xml file is created and saved to:
C:\Documents and Settings\<username>\ Max’s
Toolbox 3\Support\
(for Windows XP)

The Support tool displays information about the
configuration of the computer that Max’s Toolbox 3
is installed on. This includes the version of Max’s
Toolbox, the version of Microsoft® Office: Word,
Excel, and PowerPoint®, the operating system and
version, and information about the memory
configuration of the computer.

C:\Users\<username>\Documents\Max’s Toolbox
3\Support\
(for Windows Vista)
The folder is displayed once the file has been
created. The file can be viewed using Internet
Explorer or using a specific xml application.

The Support tool also allows this information to be
readily compiled and sent to the Max’s Toolbox 3
Support Department in order to resolve issues more
promptly by providing as much information as
possible.
To display the Support Tool:
1.

Select Start, Programs, Max’s Toolbox 3, Tools,
Support Tool.
The Max’s Toolbox 3 Support dialog box is
displayed.

2.

Click the Close button to close the support tool.

To compile support files:
1.

Select Start, Programs, Max’s Toolbox 3, Tools,
Support Tool.
The Max’s Toolbox 3 Support dialog box is
displayed.

2.

Click the Support Files button. The following
dialog box is displayed.

5.

Click the Close button once you have finished
using the Support Tool.

Max’s Toolbox™
AddIns Reset
The AddIns Reset tool can be used to renabled the
Max’s Toolbox 3 applications. If Office performs an
illegal operation and the application does not exit
properly, it may cause the Max’s Toolbox 3
application buttons to become unavailable.
Max’s Toolbox 3 can be reset individually for each
Microsoft® Office application – Word, Excel, and
PowerPoint® – or reset all for all Microsoft® Office
applications at once.
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Important Note:
Max’s Toolbox 3 only supports the distribution of
Office 97 to 2003 compatible Office files. This
enables users to be able to take home files and edit
them without needing Office 2007.
To distribute files:
1.

Select Start, Programs, Max’s Toolbox 3, Tools,
Distribution Wizard. The Distribution Wizard
dialog box is displayed.

2.

Select the appropriate level at which to
distribute files to by selecting the relevant check
box.

To reset the addins:
1.

Make sure all Microsoft® Office applications are
closed.

2.

Select Start, Programs, Max’s Toolbox 3, Tools,
AddIns Reset. The following dialog box is
displayed.

Note:
Selecting the Global check box will distribute files to
all Users of Max’s Toolbox 3.
3.

4.

Click the appropriate button (Word, Excel,
PowerPoint or Office). A progress bar will be
displayed while the addins are being reset.
Click Close when finished.

Selecting a Group check box will distribute files to all
Users of that particular group.
Selecting a User check box will only distribute files to
that particular user.

Distribution Wizard
The Distribution Wizard will enable teachers or
administrators to distribute Microsoft® Office files
for MaxWrite, MaxShow and MaxCount at the Global
(entire site), Group and User levels. The files will be
distributed to the Work save location.
This allows teachers to create documents for lessons
and then easily distribute them to each student in
the class.
The Distribution Wizard can only be used with Group
Logon Method B.
Once files have been distributed, they can be opened
using the Open dialog box in Max’s Toolbox 3.

3.

Click the Next button. The following dialog box
is displayed.
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4.

Click the Add Files button. The following dialog
box is displayed.
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9.

Confirm the distribution details, and then click
the Finish button. You can click the Back button
to modify any of the details.

10. The following dialog box will appear and display
the progress of the distribution.

5.

Select the files you want to distribute.

6.

Click the Open button. The added files will now
appear in the text box.

7.

If you want to remove a file from the list, select
the file and click the Remove button.

8.

Click the Next button. The following dialog box
is displayed.

11. Click the OK button to close the Distribution
Wizard.
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6.

If you are using the Group Logon method, the
following dialog box is displayed.

7.

Select the level to which you want to add
additional content.

Content Wizard
The Content Wizard enables teachers or
administrators to add or remove additional content
for Max’s Toolbox 3 at the Global (entire site), Group
and User levels. The files will be added or removed
from the specific content location on the local PC or
network location.
This allows teachers to compile a new set of content
for a particular class, and distribute the content to
each student.
The Content Wizard can be used with either the
Standard or Group Logon method.
Please Note: It is strongly recommended that you
disable content using the Users and Groups Tool
rather than deleting content using the Content
Wizard. Content that is available at the Global,
Group and User level can only be removed at the
Global Level.
Important Note:
Max’s Toolbox 3 only supports adding Office 2007
templates.



Global - the whole school or site



Group - a class of students e.g., 1st Grade



User - an individual student e.g., Alex
Groom

8.

Click the Next button. The following dialog box
is displayed.

9.

Select the Content Type you want to add.

To add additional Content:
1.

Select Start, Programs, Max’s Toolbox 3, Tools,
Content Wizard. The Administrator Password
dialog box is displayed.

2.

Type the password (the default password is
admin) and click OK. The Content Wizard dialog
box is displayed.

10. Click the Next button. The following dialog box
is displayed.

3.

Select the Add New Content radio button.

4.

Click the Next button.

5.

If you are using the Standard Logon method,
skip to step 9.
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11. Click the Add button to add Content.
12. If you selected Scanned Images, Movies or
Sounds, add as many content files as you
require.

For templates, the following dialog box is displayed.

If you selected Templates, add up to four
template files.
If you selected Clipart add up to nine image
files.
If you selected Stamps, or Backgrounds, add up
to eight image files.

The following dialog box will be displayed.

17. Select the template file.
18. Do one of the following:


Click the Browse button to select an image
file from the local PC or network location



Click the Pre-defined Images button to
select a pre-defined image.

19. Select an image file.

13. Select the content you want to add.

20. Click the Open button. The image file is now
shown in the preview pane.

14. Click the Open button. The content you added
will appear in the text box.

21. If you added Templates, you can add a custom
Category image file preview or a pre-defined
image file preview.
15. Click the Next button.
16. If you added Templates, you can now add a
custom template image file preview or a predefined image file preview.
If you added Backgrounds, Stamps, Movies,
Sounds, Scanned Images or Clipart, skip to step
21.

If you added Movies, Sounds, or Scanned
Images, move to step 30.
If you added Stamps, Backgrounds or Clipart,
and you want to select a Category image file
preview, move to step 27.

Max’s Toolbox™
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The following dialog box is displayed.

22. Enter a Category Name in the Category Name
field.

30. Click the Browse button to select a folder
location for the additional content. The
following dialog box is displayed.

23. Do one of the following:


Click the Browse button to select an image
file from the local PC or network location



Click the Pre-defined Images button to
select one of the pre-defined category
images.

24. Select an image file.
25. Click the Open button. The image file is shown
in the preview pane.
26. Click the Next button. Move to step 30.
The following dialog box is displayed.

31. Select a root folder location on the local PC or
network.
32. Click the OK button.
Please Note: If you are adding content for the
Group Logon method, make sure that you
specify a unique location for each level (Global,
Group or User) of content added i.e.,
\\servername\rootfolder\Global or Group name
or User name folder. Edit the destination path in
the Destination text box.
33. Click the Next button. The following dialog box
is displayed.

27. Enter a Category Name in the Category Name
field.
28. Select a Category Preview from the drop down
list. The image file is shown in the preview
pane.
29. Click the Next button. The following dialog box
is displayed.

8 Management: Administration Tools

Max’s Toolbox™
To remove existing Content:
1.

Select Start, Programs, Max’s Toolbox 3, Tools,
Content Wizard. The Content Wizard dialog box
is displayed.

2.

Select the Remove existing content radio
button.

3.

Click the Next button.

4.

If you are using the Standard Logon method,
skip to step 8.

5.

If you are using the Group Logon method, the
following dialog box is displayed.

6.

Select the level from which you want to remove
content.

34. Confirm the Content Wizard details, and then
click the Finish button. You can click the Back
button to modify any of the details.
35. The following dialog box will appear and display
the progress of the content being added.

36. Click the Close button to close the Content
Wizard.

7.



Global - the whole school or site



Group - a class of students e.g., 1st Grade



User - an individual student e.g., Alex
Groom

Click the Next button. The following dialog box
is displayed.

Max’s Toolbox™

8.

Select the Content Type you want to remove.

9.

Click the Next button. The following dialog box
is displayed.
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13. Confirm the content wizard removal details, and
then click the Finish button. You can click the
Back button to modify any of the details.
14. Click OK on the confirmation dialog to continue.

15. The following dialog box will appear and display
the progress of the content being removed.

10. If you are using the Standard Logon method, all
available content will be displayed.
If you are using the Group Logon method, all
available content for the particular level
(Global, Group or User) will be displayed.
11. Do one of the following:


Remove Entire Content Locations and Files
by selecting the check box next to the root
folder i.e., Movies (C:\Documents and
Settings\All Users\Documents\)



Remove Single Files by selecting the check
box next to a single file i.e., 123_ani.avi .

12. Click the Next button. The following dialog box
is displayed.

16. Click the Close button to close the Content
Wizard.
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Troubleshooting
Product Registration Messages
Issue: When launching Max’s Toolbox, a message appears that says the evaluation period will expire in a certain
number of days, or the evaluation period has expired.
Description: The product can be run for a 45-day evaluation period without purchase. This message reminds you
how much time you have left to evaluate the product.
Solution: If you have not yet purchased Max’s Toolbox, you are free to use the product with all of its features
for the duration of your evaluation period. Simply click the red ―X‖ to get past this registration prompt and run
Max’s Toolbox. If you have already purchased Max’s Toolbox and have your serial number ready, click the green
checkmark to register your product. Your serial number is printed on a white sticker on the back of the Max’s
Toolbox CD case.
If you do not have a serial number, please call your authorized dealer to purchase the product and receive a serial
number.

Page Borders in MaxWrite
Issue: The Page Borders feature does not work.
Description: If Page Borders do not work in Max’s Toolbox, it is likely that the art border feature was not included
®
in your original installation of Microsoft Office.
Solution: Adding the page borders feature to your Office installation should solve the problem. Follow the steps
below to do this.
1.
2.
3.
4.
5.
6.

Launch Microsoft® Word.
Choose Borders and Shading from the Format menu.
Click the Page Borders tab.
®
Select the Art drop-down menu. The Microsoft Office Word dialog displays, and reads: ―Microsoft Office
Word can’t display the border art in this document. This feature is not currently installed.
Would you like to install it now? Yes. No.‖
Click Yes in the dialog. The Installing Components for Microsoft Word dialog is displayed.
Click OK in the Borders and Shading menu.

Launching MaxWrite
Issue: Launching MaxWrite launches Microsoft® Word, not MaxWrite.
Description: Microsoft Office may have disabled Max’s Toolbox within Microsoft Word.
Solution: For Office XP and Office 2003:
1.
2.
3.

Choose About Microsoft Word from the Word Help menu.
In the About dialog, click the Disabled Items button.
If you see Max’s Toolbox listed as a disabled item, click the button to enable it.
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Large Font System Setting
Issue: Large font setting introduces problems.
Description: A variety of problems have been detected on systems that have been set up to use large fonts (120
dpi).
Solution: Setting the system to the normal (96 dpi) font setting fixes these problems. To check or change your
system font, do the following:
1.
2.
3.
4.
5.

Right-click the desktop and select Properties.
Click the Settings tab.
Click the Advanced button.
Your current font is displayed on the General tab.
If you are currently using something other than the 96 dpi font setting, use the drop-down arrow to select
this setting.

Error Messages
Issue: ―Unknown Error‖ or ―Could not perform requested function‖ error messages appear.
Description: Some Microsoft® Office error messages will not translate into Max’s Toolbox, resulting in these
generic messages.
Below are two situations that might cause this:
®

1. Your version of Microsoft Office might not have all the features installed. It is essential that you have a full
®
installation of Microsoft Office. A component of Office that schools often do not install is the MS Office Assistant.
®

Solution: Go to Start/Settings/Control Panel and double-click Add/Remove Programs. Select Microsoft Office
from the list of programs. Click Change. Click Add or Remove Features and add any missing features. This might
®
require your original Microsoft Office installation CD.
®

2. Under Windows 2000 and Windows XP, each user account must launch Microsoft Word at least once prior to the
first launch of MaxWrite.
®

Solution: Be sure Microsoft Word has been run at least once prior to the first launch of MaxWrite.
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Technical Support
If you experience problems with Max’s Toolbox, you have several resources including the Installation
Guide on the CD-ROM and our Web site. You can visit our Web site’s technical support area to view a
list of Frequently Asked Questions (FAQs).

Contacting us:

Email:
support@maxstoolbox.com

Web:
www.maxstoolbox.com
When requesting support, please have the following information available:





Name of the software and version number
Your computer’s operating system
Your computer’s memory (RAM)
Your computer’s speed and processor type

